
Overview 

System Capabilities 
The Document Management System is an automated document management tool.  DMS stores 
a wide variety of documents in an indexed database for easy retrieval.  Documents are added to 
the database using a scanner or by importing word processor or spreadsheet files and may be 
quickly retrieved via keyword search or full text search.  In addition, DMS may be used to 
view, print, fax, e-mail, or export any document in the database.  Several users may share the 
one or several DMS databases over a network and use them simultaneously 

System requirements 
The specifications listed below are the minimum system requirements for running DMS. 

Intel Pentium (or equivalent) processor 
16 MB memory 
50 MB disk space 
Windows 95 OSR2 or Windows NT 4.0 
Microsoft Word 6.0 
Windows 95 OSR2 
TWAIN compliant scanner with ADF (Automatic Document Feeder) 
TWAIN scanner drivers 



Functions 
This section describes the overall functions and processes in DMS.  Detailed instructions on 
how to perform individual tasks if given in the tasks section. 

Images 
When documents are added to the DMS database using a scanner the original image file is 
maintained in the database to preserve the document’s appearance.  OCR (Optical Character 
Recognition) is performed to extract and index the document’s text and store it to the database.  
If keywords have been defined they may also be indexed and stored to the database.  Multi-
page documents may be scanned using a scanner with an ADF (Automatic Document Feeder).  
Image files may also be imported into the DMS database from disk.  Scanning resolution may 
be customized to obtain optimum image quality. 

Word Processor Files 
When word processor files and spreadsheets are added to the DMS database, they are 
automatically converted to the Microsoft Word format.  Any word processor or spreadsheet 
format that Microsoft Word supports may be used, including WordPerfect, Excel, and Text 
files.  The text of the imported file is indexed and stored to the database.  If keywords have 
been defined they may also be indexed and stored to the database.  Multiple files may be 
simultaneously imported into the DMS database from disk, making it easy to store and catalog 
several files. 

Document Types and Keywords 
To facilitate indexing of documents in the DMS database, Document Types and Keywords 
Definitions are setup by the user for page layouts that are commonly used.  Each Document 
Type may contain several Keywords Definitions.  Keywords are key document items that are to 
be automatically indexed and used to retrieve documents from the database.  Examples of 
keywords are Customer Name, Due Date, Social Security Number, Date of Birth, Age, etc. 

Keywords Definitions are either zone-based or label-based or manual. 

Zone-based keywords 
Zone-based keywords definitions specify the coordinates on a scanned image where specific 
keyword text is located.  The user specifies the location of the keyword by providing top, 
bottom, left, and right page coordinates.  These zone coordinates are supplied by either entering 
them directly or drawing the zone on a test image with the mouse.  Additionally, it is possible to 
specify text (such as column headers and labels) to automatically remove from the zone during 
OCR.  Zone-based keywords are not available with word processor files. 

Label-based keywords 
Label-based keyword definitions specify a text string that precedes the keyword text, such as 
“Name:”.  The first word following the label is stored as the label text.  For example, if the 



following text appeared in a document and a label-based keyword was defined using the label 
“Name:”, the word “Smith” would be stored as the keyword text. 
 Name:  Smith, John B. 
  Age:  28 
  Sex:  Male 

Manual keywords 
A keyword is considered to be a manual keyword if the Auto-Detect Keyword feature for the 
keyword is disabled.  OCR is not used to determine the keyword text for manual keywords.  
Instead, the user enters the keyword text manually or leaves it blank.  Manual keyword are 
useful for storing information that does not appear in documents at a consistent location or with 
a consistent label.  For example, a keyword such as “Other Information” could be defined for 
this purpose. 

Searching 
Documents are retrieved from the database via keyword search , full-text search, or browsing.  
A keyword search is performed by specifying the document type and keyword text of the 
desired documents.  For example, selecting the document type “Neurodiagnostics Report” and 
entering the keyword text “Smith” for the Patient Name keyword would display all of the 
Neurodiagnostic Reports in the database for patient with the last name Smith.  A full-text search 
is performed by specifying a word within the document body to search for.  This type of search 
is most often used to perform ad-hoc searches for information not contained in keywords.  For 
example, performing a full-text search on the word “epidermis” displays all documents where 
the word “epidermis” appears in the text body.  Keyword searches and full-text searches may 
be combined to create more specific search criteria. 

Security 
DMS provides several security features.  Each feature (described below) is a user option.  
Security features may be combined or omitted as desired to create a level of security that meets 
the users needs. 

Document Security 
Individual documents in the database may be password protected..  Only those users 
possessing the correct document password are able to use DMS to view or edit password 
protected documents.  

Document Type Security 
Entire document types may be password protected.  Only those users possessing the correct 
document type password are able to use DMS to view or edit documents of password-
protected document types.  A password is also required to view or modify keyword definitions 
of password-protected document types. 

Database Security 
DMS database files may be password protected.  Only those users possessing the correct 
database password are able to open password-protected databases.  The database password 



is stored within the database itself so it also prevents the DMS database from being opened by 
other compatible database programs.  In addition each database file and all passwords 
(document, document type, and database) within each database are automatically encrypted, 
making it difficult for a “hacker” to gain access. 

Customizable Security Levels 
The three types of security mentioned above may be combined in any way to meet the security 
needs of the user.  Users working with sensitive documents may assign passwords to every 
database, document type, and document.  If only a small number of items require protecting, 
password may be assigned to individual documents or document types, leaving unrestricted 
access to the rest.  Password may be omitted entirely, if desired, to give full access to everyone. 

Password Cache 
Each time a password is entered to access a password protected item, the password is saved in 
memory.  This cache of passwords allows several items protected by the same password to be 
accessed without re-entering the password each time.  The password cache is cleared when 
DMS is exited. 

Workgroup Support 
DMS is designed to meet he document needs of workgroups of any size.  DMS supports 
multiple users and multiple databases. 

Multiple Databases 
DMS provides a way to administer several different databases.  Using this feature, members of 
a workgroup could maintain personal DMS databases while still having access to a shared 
workgroup databases over the network.  The ability to administer separate DMS databases 
also makes it easier to copy, move, backup, and distribute collections of documents. 

Multiple Users 
DMS databases support multi-user access.  The means that several users are able to access the 
same DMS database over the network concurrently.  For example, several workgroup 
members may scan images while others import word processor files, create new document 
types, search for document, and print documents. 

OCR 
Optical Character Recognition, or OCR, is a means of extracting text information from images 
such as scanner images.  Images of a document produced by a scanner are, in essence, “digital 
photocopies” or “pictures” of a document containing individual image pixels instead of text 
characters.  As such, images retain the original documents appearance very well and are easily 
viewed, printed, faxed, etc.  However, a images cannot be easily edited with a word processor 
program since they contain no actual text characters. 

OCR Tradeoffs 
OCR is used to convert the pixel of an image document to actual text characters.  DMS uses 
OCR to extract text from scanner images for keyword and full-text searches.  Since OCR relies 



upon pixel patterns to recognize individual characters, its accuracy depends on the quality and 
resolution of the scanned image.  Therefore, scanning a high quality original document at high 
resolution yields higher OCR accuracy than scanning a low-quality faxed or photocopied 
document at low resolution.  However, high resolution images require more storage space and 
more time for OCR.  DMS provides a way to specify default scanning resolutions for each 
document type so that storage requirements, OCR performance, and OCR accuracy may be 
optimized to user requirements. 

Caere OCR Engine 
An OCR engine form Caere Corporation is provided with DMS.  Caere is recognizes as an 
industry leader in OCR technology and provides one of the fastest, most accurate OCR engines 
available.  Once the OCR engine is registered the full capabilities of Caere’s OCR engine will 
become available through DMS. 

Word Processor Documents 
Word Processor files do not require OCR since they already contain text characters.  When 
DMS performs OCR functions on these documents, it simply exports the text directly from the 
file using Microsoft Word.  Also, only label-based keyword detection 

Using OCR 
DMS makes it easy to perform OCR on scanned or imported images. 

Automatic OCR 
By default, OCR is automatically performed on any document scanned or imported into the 
DMS database.  This feature may be disabled, if desired, to save time during scanning or 
importing or if OCR is not required. 

Batch OCR 
Batch OCR is used to perform OCR on images already in the database.  Using Batch OCR, 
OCR can be performed on a single document or on several documents consecutively without 
user interaction.  Batch OCR is useful for performing OCR on documents that did not have 
OCR performed when they were originally added to the database.  It is also useful if OCR 
needs to be performed again due to new or revised keyword definitions. 

Viewing Documents 
Image documents and word processor documents may be viewed upon scanning or import 
before they are stored in the database.  Documents in the database may also be viewed by 
searching for the desired document and selecting it from the list of documents that match the 
search criteria. 

Viewing images 
Images are displayed by DMS upon scanning and importing and by searching for an image in 
the database.  The user can scroll the displayed image and change the zoom.  For multi-page 
images, the page to view may be selected or all pages may be viewed at once as miniature 
thumbnails. 



Viewing word processor files 
Word processor files are displayed by DMS as a Microsoft Word icon upon scanning and 
importing and by searching for an image in the database.  Double-clicking on the Microsoft 
Word icon opens the document with Microsoft Word.  The document the may be viewed or 
edited using Microsoft Word. 



Tasks 

Creating a New Image Database 

To create a new image database, choose New Image Database from the File menu.  Enter a 
name for the new database when the New Image Database dialog is displayed.  A new image 
database will be created and opened using the name you provide.  Once a new image database 
is created and opened new document types and images may be added to it. 

If the New Image Database option is chosen when another database is already open, the 
currently open database is closed. 

 



Opening an Image Database 

To open an existing image database, choose Open Image Database from the File menu.  Then, 
select the desired database when the Open Image Database dialog is displayed.  The selected 
database is opened as the current image database. 

The names of the four most recently used databases appear as numbered menu items in the File 
menu.  If the image database you wish to open appears as a numbered item in the File menu it 
may be opened more quickly by choosing it directly from the menu instead of using the Open 
Image Database menu option. 

If the New Image Database option is chosen when another database is already open, the 
currently open database is closed. 

 



Closing an Image Database 

To close the currently open image database, choose Close Image Database from the File menu. 

The currently open image database is automatically closed by choosing any of the following 
items from the File menu. 



Exiting 

To exit the program, choose Exit from the file menu. 



Copying a Database 

To copy a database, choose Copy Database from the File menu.  Select the name of the 
database to be copied when the Database Copy From dialog is displayed.  Enter the name of 
the new database to create when the Copy Database Into dialog is displayed. 

During the copying process the source database is automatically compacted.  Depending on the 
size of the database, the copying and compacting process may take several minutes.  A 
message box appears to indicate the copying and compacting process is complete. 

A database cannot be copied when it is in use.  Make sure all users including yourself have 
closed the database you wish to copy before attempting to copy it.  An error message will be 
displayed if an attempt is made to copy a database that is currently in use. 

 

 



Compacting a Database 

To compact a database, choose Compact Database form the File menu.  Select the name of the 
database to be compacted when the Compact Database dialog is displayed. 

Depending on the size of the database, it may take several minutes to compact it.  A message 
box will appear when the compacting process is complete. 

A database cannot be copied when it is in use.  Make sure all users including yourself have 
closed the database you wish to compact before attempting to compact it.  An error message 
will be displayed if an attempt is made to compact a database that is currently in use. 

A database is automatically compacted when it is copied using Copy Database from the File 
menu. 

Compacting reduces the size of a database and increases database performance.  Compacting 
reduces database size by removing wasted space that forms as records are deleted.  
Compacting increases database performance by rebuilding indexes that become unbalanced as 
new records are added. 

 



Backing Up a Database 

To backup a database, choose Backup Database from the file menu.  Select the name of the 
database to backup when the Backup Database dialog is displayed. 

The backup process compacts and copies the selected database.  The backup copy of the 
database is named based on the current date and time. 

Depending on the size of the database, it may take several minutes to backup.  A message box 
will appear when the backup process is complete. 

A database cannot be backed up when it is in use.  Make sure all users including yourself have 
closed the database you wish to backup before attempting a backup.  An error message will be 
displayed if an attempt is made to backup a database that is currently in use. 

 



Purging Backups 

To purge old backups, choose Purge Backups from the file. 

Purging backups deletes all backup files except for the ten most recent backups. 



Setting Up Printers 

To setup up printers, choose Print Setup from the file menu.  Select the name of the printer to 
use for printing images and documents when the Print Setup dialog will be displayed.  Other 
properties such as page size and orientation may also be selected. 

 



Printing Documents. 

To print a document. 

Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

Select the desired documents from the Documents Found list box.  Multiple documents may be 
selected at once.  See Multi-Select List Boxes and Dialogs for more information. 

Print the selected document(s) by clicking the Print button or choosing Print from the file menu. 



Setting Up Mail 

To setup mail, choose Mail Setup from the File menu.  The Mail Setup dialog will be displayed.  
The mail setup screen may also be accessed by clicking the Setup button in the Send dialog 
when mailing a document. 

Mail may be configured for three types of mail services:  Microsoft Exchange, Lotus cc:Mail, 
and SMTP/POP3 (Internet mail).  Configuring mail for the mail service you use will enable you 
to send copies of images and documents to others directly from the database. 

To configure mail for Microsoft Exchange, select the Exchange tab on the Mail Setup screen.  
Enter the profile name to use when sending mail using Exchange.  Unless your Windows mail 
system has been customized your profile name will be "MS Exchange Settings".  In order to 
send Exchange mail you must first setup Exchange on your system by double-clicking on the 
Inbox on the Windows desktop. 

 

To configure mail for Lotus cc:Mail, select the cc:Mail tab on the Mail Setup screen.  Enter the 
user name and password to use when sending mail.  If the user name and password are left 
blank you will be prompted for them whenever you mail a document.  Note that if you supply a 
password in the Mail Setup screen others may be able to send mail from within the program 
using your user name and password.  In order to send cc:Mail you must have the 32-bit VIM 
client on your system. 

 

To configure SMTP/POP3 mail, select the SMTP/POP3 tab on the Mail Setup screen.  Enter 
the POP account.  Enter the POP password for the account.  Note that if you supply a 
password in Mail Setup others may be able to send mail from within the program using your 
user name and password.  Your will be prompted for a password when sending mail if you omit 
it.  Enter an SMTP server name such as mailhost.worldnet.att.net. Enter a POP3 server name 



such as postoffice.worldnet.att.net.  In order to send SMTP/POP3 mail you must have access 
to an Internet mail server. 

 

Mail recipients may be viewed and edited and created in the Address Book by clicking the 
Addresses button on the Mail Setup screen.  See Address Book for more information. 



Address Book 

The Address Book is accessed from the Mail Setup dialog.  To open the Address Book, 
choose Mail Setup from the file menu and click the Addresses button on the Mail Setup dialog.  
The Address Book may also be accessed by clicking the Mail To button on the Send dialog 
when mailing a document.  In the address book, the name, address, and mail type of mail 
recipients are displayed in a list box. 

To edit a mail recipient's information, select the recipient in the list box.  The name, mail 
address, and mail type for the selected recipient are displayed and may be edited in the fields 
below the list box. 

To add a mail recipient, click the Add button.  A new recipient will be added to the list box.  Fill 
in the name and mail address of the recipient in the Name and E-Mail Address fields.  Select the 
mail type by choosing either the Exchange, cc:Mail, or SMTP/POP3 radio button. 

To delete a mail recipient, select the mail recipient in the list box and click the Delete button. 

 



Sending Documents 

To send a document: 

Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

Select Send from the file menu.  The Send dialog box will be displayed. 

Type the mail address of the desired recipient in the Mail To field.  Recipients may be selected 
from the Address Book by clicking the Mail To button. 

Select the mail type by choosing the Exchange, cc:Mail, or SMTP/POP3 radio button. 

Type the mail subject in the Subject field.  The subject is initially defaulted to the title of the 
document from the database. 

Type an optional message to in the Note field. 

Click the Send button. 

The Mail Setup dialog may be accessed by clicking the Setup button if changes need to be 
made to the mail configuration before sending. 

 



Exporting Documents 

To export a document: 

Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

Select Export from the File menu.  The Export dialog will be displayed. 

Type the file name of the document to be created from the database. 

Click the save button. 

 



Searching for Documents 

To search for a document: 

Choose Search Database from the Query menu. 

Select the document type of the document you wish to find in the Document Type drop-down 
list box. 

Enter any description and/or keywords that describe the document in the Keyword Description 
fields. 

Enter any text to search for in the Containing Text field. 

Click the Search button. 

If the desired document is not displayed in the Documents Found list box, revise the search 
criteria and click the Search button again. 

Click on the desired document in the Documents Found list box.  It will be displayed in the 
image pane on the right-hand side of the screen. 

 



Setting Up Scanner 

To setup a TWAIN scanner, choose Scanner Setup from the Scan menu.  The Scanner Setup 
dialog for your scanner will be displayed.  Use the scanner setup dialog to set the desired color 
depth and resolution and page size to use when scanning. 

TWAIN scanner drivers must be installed to run Scanner Setup. 



Scanning Documents 

To scan a document: 

1. Choose Scan Documents from the Scan menu.  The Scan Documents screen will be 
displayed. 

2. Select the document type of the document to be scanned from the Document Type drop-
down list box. 

3. Check the Automatic OCR check box to automatically perform OCR when scanning is 
complete.  See Performing OCR for more information. 

4. Click the Scan button.  The scan dialog will be displayed 

  

5. Select the Single-Page Documents radio button if the document(s) to be scanned contain 
only one page each.  Select Multi-Page Documents radio button if each document to be 
scanned contains more than one page.  If scanning multi-page documents, enter the number 
of pages per document. 

6. Check the check box labeled “Scan and save all documents until Automatic Document 
Feeder is empty” if the ADF is being used to scan several documents. 

7. Click the OK button to begin scanning.  If the “Scan and save all documents…” check box 
was checked, all documents in the ADF will be scanned and saved to the database.  
Otherwise, a single document will be scanned and its image displayed. 



 



Importing Documents 

To import an existing TIFF image, Microsoft Word document, or WordPerfect document into 
the database: 

Choose Scan Documents from the Scan menu. 

Select the document type of the document to be imported from the Document Type drop-down 
list box. 

Click the Import button.  The Import Image dialog will be displayed. 

Select the file to be imported from the dialog box and click OK.  If the file selected is a TIFF 
file it will be displayed on the Scan Documents screen.  If the selected file is a Microsoft word 
or WordPerfect file an icon will be displayed on the screen representing the document. 

Microsoft Word must be installed in order to import Microsoft Word documents.  WordPerfect 
and other word processor formats may also be imported if the appropriate conversion filters 
have been installed in Microsoft Word.  Run Microsoft Word setup to install additional 
conversion filters. 

 



Performing OCR 

To perform Optical Character Recognition (OCR) on a newly scanned or imported document: 

1. Scan or import a document.  See Scanning Documents and Importing Documents for more 
information.  If the Automatic OCR check box was checked prior to scanning or importing, 
OCR will proceed automatically. 

2. If the Automatic OCR check box was not checked, click the Do OCR button to perform 
OCR. 

3. The OCR keywords and text will be displayed on the Scan Documents screen when OCR 
is complete. 

To perform OCR on a documents that are in the database: 

1. Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

2. Select the desired documents from the Documents Found list box.  Multiple documents may 
be selected at once.  See Multi-Select List Boxes and Dialogs for more information. 

3. Perform OCR on the selected document(s) by clicking the Batch OCR button. 

4. The OCR keywords and text will be created and created and saved in the database for 
each selected document. 



Editing OCR Text 

To edit the OCR text of a newly scanned or imported document: 

1. Scan or import a document using the Scan Documents screen.  See Scanning Documents 
and Importing Documents for more information. 

2. Perform OCR on the scanned or imported document.  See Performing OCR for more 
information. 

3. Click the Edit Text button.  The Edit Text dialog will be displayed. 

4. Modify the text displayed on the Edit Text screen as desired. 

5. Click OK to save changes to OCR text or Cancel to discard changes. 

To edit OCR text of a document that is in the database: 

1. Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

2. Select the desired document from the Documents Found list box. 

3. Click the Edit Text button.  The Edit Text dialog will be displayed. 

4. Modify the text displayed on the Edit Text screen as desired. 

5. Click OK to save changes to OCR text or Cancel to discard changes. 

 



Editing Keywords 

To edit the keywords of a newly scanned or imported document. 

Scan or import a document using the Scan Documents screen.  See Scanning Documents and 
Importing Documents for more information. 

If desired, perform OCR on the scanned or imported document.  See Performing OCR for 
more information. 

Modify keywords as desired in the Keyword grid.  The name of the keyword is displayed in the 
first column of the grid.  The keyword text is entered and edited in the second column.  The first 
keyword is always “Description.”  The remaining keywords may be customized for each 
document type.  See Editing Document Types for more information. 

To edit keywords of a document that is in the database: 

Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

Select the desired document from the Documents Found list box. 

Click the Edit Keywords button.  The Edit Document Keywords dialog will be displayed. 

Modify keyword as desired in the Keyword grid. 

Click OK to save changes to keywords or Cancel to discard changes. 

 



Saving Documents 

To save newly scanned or imported documents: 

Scan or import a document using the Scan Documents screen.  See Scanning Documents and 
Importing Documents for more information. 

If desired, perform OCR on the scanned or imported document.  See Performing OCR for 
more information. 

Enter document description and keywords for the document.  A description and at least one 
keyword is required.  See Editing Keywords for more information. 

Click the Save button.  The document will be saved along with its keywords and OCR text. 



Multi-Select List Boxes and Dialogs 

Some list boxes and dialogs allow for the selection of several items at once. 

To select multiple contiguous items in a multi-select list box or dialog: 

Select the first desired item. 

Hold down the Shift key while clicking the last desired item in the range.  All items between the 
first and last item inclusive will be selected 

To select multiple individual items in a multi-select list box or dialog: 

Select the first desired item. 

Hold down the Ctrl key while clicking every other desired item.  Only the items that are clicked 
will be selected. 



Adding Document Types 

To add a document type: 

Select Setup Documents from the Scan menu.  The Document Types screen will be displayed 
showing a list of all available document types. 

Click the Add button.  The Add Document Type dialog will display. 

Type the description of the Document Type being added and click OK.  A document type 
having specified description will be added to the list of Document Types on the Document 
Types screen. 

 



Deleting Document Types 

Select Setup Documents from the Scan menu.  The Document Types screen will be displayed 
showing a list of all available document types. 

Select the document type to delete and click the Delete button. 

A message will warn before deleting if there are any documents in the database under the 
selected document type.  All documents, keywords and text stored under a document type are 
deleted when a document type is deleted. 

Click OK when the warning message is displayed to continue deleting or click Cancel to abort 
deleting.  The document type will be deleted from the database and removed from the 
Document Types screen. 



Editing Document Types 

Select Setup Documents from the Scan menu.  The Document Types screen will be displayed 
showing a list of all available document types. 

Select the document type to edit and click the Edit button.  The Edit Document Type screen will 
display. 

Edit the name and description of the document type displayed in the Name and Description 
field. 

Select the scanning resolution in the Scanning Resolution list box.  The resolution chosen will be 
used to automatically set the scanner resolution when scanning documents.  Your scanner and 
TWAIN scanner drivers may not support this option and may require setting scanner resolution 
manually before scanning.  See Setting Up Scanner for more information on manually setting 
scanner resolution. 

To add a keyword name to the document type:  Click the Add button, type the name of the 
keyword when the Add Keyword Name dialog is displayed, then click OK. 

To edit a keyword name:  Select the keyword, Click the Edit button, modify the name of the 
keyword when the Edit Keyword Name dialog is displayed, then click OK. 

To delete a keyword name:  Select the keyword and click the Delete button. A message will 
warn before deleting if any documents in the database have keywords stored under the selected 
keyword name.  All keywords of all documents stored under a keyword name are deleted 
when a keyword name is deleted.  Click OK when the warning message is displayed to 
continue deleting or click Cancel to abort deleting.  The keyword name will be deleted from the 
database and removed from the Keywords list box. 

To setup a keyword’s attributes, click on the desired keyword in the Keywords list box and do 
the following: 

Check the Automatically Detect Keywords check box to automatically extract keywords from 
OCR text when scanning or importing.  Check off the check box to enter keywords manually 
when scanning or importing. 

If Automatically Detect Keywords is selected, select label or Zone Auto Keyword Detect Type 
by clicking the Label or Zone radio button.  Label detection recognizes keywords by the text 
that precedes them.  Zone detection recognizes keywords by their position on the page. 

If label detection is selected, enter the label text that will be used to detect the keyword.  For 
example, “Physician:”  Colons and similar punctuation should be included if they appear on the 



page.  If the entire label text is too long to fit in the Label field, enter the rightmost characters 
only.  For example, enter “of Birth:” to represent the label text “Date of Birth:” 

If Zone detection is selected, enter the top, bottom, left and right coordinates defining the 
keywords location on the page.  Clicking the Scan button will scan a test image and display it.  
Click on and drag on the test image to define zones graphically and automatically insert 
coordinates in the Top, Bottom, Left, and Right fields. 

If Zone detection is selected, enter any text to be discarded from the zone text in the Remove 
Text field.  This option is commonly used when a descriptive label such as “Name:” appears 
directly above the desired keyword on the page.  Keyword zone coordinates are defined to 
include the descriptive label and the label is removed during keyword detection. 

Click OK to save changes, or Cancel to discard changes. 

 



Deleting Documents 

To delete a document from the database: 

Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

Select the desired documents from the Documents Found list box.  Multiple documents may be 
selected at once.  See Multi-Select List Boxes and Dialogs for more information. 

Click the Delete button to deleted the selected documents. 

Compacting a database after deleting several documents from it will reduce the database files 
size.  See Compacting a Database for more information. 



Editing Documents 

To edit a Microsoft Word document that has been imported into the database: 

Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

Select the desired document in the Documents Found list box.  An icon will appear in the image 
pane. 

Double-click on the icon.  The document will be opened in Microsoft Word. 

View and modify the document as desired. 

Close the document, saving changes if necessary. 

Exit or minimize Microsoft Word. 

Microsoft Word must be installed in order to view documents in the database. 



Zooming In or Out of a Document 

To changed to magnification of a displayed TIFF image, select one of the following from the 
View menu: 

Zoom In - Incrementally increase magnification. 

Zoom Out - Incrementally decrease magnification 

Fit to Height - Set magnification so that entire height of image fits within image pane. 

Fit to Width = Set magnification so that entire width of image fits within image pane. 

Best Fit - Set magnification so that entire height and width of image fits within image pane. 

Actual Size - Set magnification so that displayed image is same size as original scanned page. 

10%, 25%, 50%, 75%, 100%, 200%, 400% - Set magnification to specified value. 

Custom - Set magnification to a user-defined value.  A dialog will display for entering custom 
magnification. 



Viewing Multi-Page Documents 

To view the different pages of a multi-page TIFF image, select one of the following from the 
Page menu: 

Next - Display the page after the page currently displayed page. 

Previous - Display the page before the currently displayed page. 

First - Display page one of the image. 

Last - Display the last page of the image. 

Go To - Display a specified page of the image.  A dialog will display for entering the page 
number to view. 

Thumbnails - Display all pages of the image simultaneously in the Image Thumbnails dialog.  The 
page selected from the Image Thumbnails dialog is displayed when the dialog is closed. 

 



Changing Database Passwords 
To change a database password or assign a password to a database that is not yet password-
protected: 

1.  Select Change Database Password from the File menu.  A file dialog will display. 

2.  Select the database from the file dialog for which the password is to be changed.  Note that 
a database password cannot be changed while it is in use. 

3.  If the database has been previously password-protected, the Enter Password dialog will 
display.  The previous password must be supplied before the password can be changed.  
Enter the password and click OK. 

  
4.  The Change Password dialog will display.  Enter the new database password (or leave 

blank to remove password) in the New Password field.  Enter the new password again in 
the Verify field and click OK. 

  



Changing Document Type Passwords 
To change a Document Type password or assign a password to a Document Type that is not 
yet password-protected: 

1.  Select Setup Documents from the Scan menu.  The Edit Document Type screen will 
display. 

2.  Select the document type from the Document Type combo box for which the password is 
to be changed.  If there is a password already assigned to the selected document type, enter 
it when prompted. 

3.  Select the Information tab. 

4.  Click the Password checkbox.  The Change Password dialog will display. 

5.  Enter the new document type password in the New Password field (or leave blank to 
remove password). 

6.  Enter the new password again in the Verify field and click OK. 

 

 



Changing Document Passwords 
To change a Document password or assign a password to a Document that is not yet 
password-protected: 

1.  Select Search Database from the Query menu.  The Search Document Database screen will 
display. 

2.  Search for and display the desired document using the Query screen.  See Searching for 
Documents for more information. 

3.  Select the Information tab. 

4.  Choose Change Document Password from the File menu.  If there is a password already 
assigned to the selected document, enter it when prompted. 

5.  The Change Password dialog will display.  Enter the new document password in the New 
Password field (or leave blank to remove password). 

6.  Enter the new password again in the Verify field and click OK. 

 



Registering OCR 
Once the Caere OCR engine has been registered, a name and password will be provided for 
enabling the OCR capabilities of DMS.  To enable OCR capabilities: 

1.  Choose About from the Help menu.  The About screen will be displayed. 

  
2.  Click Register OCR button.  The Register OCR screen will be displayed.  Note that OCR 

features are already activated if the Register OCR button on the About screen is disabled. 

3.  Enter the name and password supplied when the Caere OCR engine was registered.  Enter 
an optional company name. 

4.  Click OK.  If information was entered correctly a message will display indicating that OCR 
features have been activated. 



Guidelines 

Security Guidelines 
Here are a few useful ideas to keep in mind when managing the security of DMS databases. 

Password capitalization. 
DMS passwords are case-sensitive, which means the password “secret”, “Secret”, and 
“SECRET” are not the same.  Pay attention to the state of the Caps-lock key when typing 
passwords.  Use all uppercase or all lowercase passwords to create simple passwords that are 
easy to remember.  For passwords that are more difficult for others to guess or “crack,” use a 
combination of uppercase letters, lowercase letters, numbers and symbols. 

Write down passwords 
Always write down passwords and keep them in a safe place.  Don’t rely on memory for 
important passwords.  There could easily be a large number of passwords to remember if 
several databases or document types are implemented and individual documents or password-
protected..  If a password for a database, document type or document is lost or forgotten, the 
password protected items will not be accessible.  This is especially important since forgetting a 
database password could result in the loss of every document in the database.  DMS database 
passwords provide true security for confidential documents.  There is not a “magic emergency 
password” that GoughSoft can use to unlock a password-protected  database after the 
password has been forgotten. 

Re-use passwords 
Minimize the number of passwords to keep track of whenever possible.  Assign the same 
password to items that the same person or group of people regularly access. 

Use security tiers 
Whenever possible, minimize the number of password protected items that have to be kept 
track of by utilizing document type and database security features in lieu of password-protecting 
individual documents.  Avoid assigning passwords to every document if a document type 
password will suffice.  Don’t assign passwords to individual document types if a single 
database-level password will suffice. 

Use separate databases 
Instead of assigning password to individual documents or document types, separate groups of 
confidential documents into different password-protected databases based on the people that 
need access to them. 

Use separate document types 
Compartmentalize confidential documents by setting up additional password-protected 
document types.  For example, the document type “Test Results” could contain general access 
documents and a password-protected document type named “Test Results (Confidential)” 
could be added for confidential documents. 



Change passwords regularly 
Be sure to change passwords on a regular basis, especially if someone has left the workgroup 
that previously had access to confidential data. 

Scanning Guidelines 
Here are a few useful ideas to keep in mind when scanning documents with DMS. 

Use lowest acceptable resolution 
The disk space required to store a scanned image increases by a factor of four each time the 
image resolution is doubled.  For example, a 200 x 200 DPI image requires four times the disk 
space as a 100 x 100 DPI image.  The same concept applied to the amount if time required to 
perform OCR on the image.  Scanning in lower resolutions whenever possible will reduce disk 
space requirements and increase OCR performance.  However, using lower resolution reduces 
OCR accuracy so a balance must be achieved between desired OCR accuracy and image 
resolution.  Use the following as general resolution guidelines. 

 100 x 100 Screen viewing only, hand-written documents 
 200 x 100 Faxing, fast OCR 
 200 x 200 Minimum resolution for good OCR quality. 
 300 x 300 High quality printouts and extremely accurate OCR. 

Avoid scanning in color or halftones 
A scanner setting of Black and White Drawing or similar for best results.  Color and halftone 
(sometime called grayscale) scans are best suited for photographs, not typeset documents.  
Color and halftone require many times the storage space of two-tone black and white scans.  In 
addition, they result in unacceptable OCR quality and printouts that have a gray or dirty-looking 
background. 

Use original word processor files 
Store the original word processor files in the database if they are available.  Word processor 
files take up less space and text is extracted faster and with 100% accuracy.  Printouts and 
faxes of word processor documents are also of higher quality.  In general it is of little benefit to 
print out a word processor file and then scan it into the database when the original word 
processor file could be imported into the database itself with better results. 

Use Automatic Document Feeder 
The ADF may be used even if single documents are being scanned using manual keywords.  
Placing documents in the ADF saves the time required to place individual documents under the 
scanner cover.  If the check box on the Scan dialog titled “Scan and save all documents until 
Automatic Document Feeder is empty” is not marked, the scanner will scan the specified 
number of pages using the ADF and then stop.  After entering keywords and saving, scanning 
may be resumed with the next page in the ADF by clicking scan again.  An ADF is required for 
scanning multi-page documents. 

Scan without OCR 
To save time while scanning, unmark the Automatic OCR check box and save documents 



without performing OCR.  Then perform Batch OCR at al later time on all of the newly scanned 
documents using the Search Document Database screen. 

Verify accuracy before saving 
To ensure keyword accuracy, scan one document at a time and verify the accuracy of the 
automatically detected keywords before saving.  If keywords are not correct due to OCR 
errors, they may be corrected before saving.  The actual text of the document body may also be 
edited before saving by clicking the Edit Text button. 

Enter a useful description 
When a document is scanned or imported the description defaults to “Scan MM/DD/YY 
HH:MM:SS” or “Word MM/DD/YY HH:MM:SS” where “MM/DD/YY HH:MM:SS” is the 
date and time.  Immediately after scanning or importing the Description field is highlighted for 
easy editing.  Entering a more descriptive document name will make it easier to search for and 
find the document in the future. 

Microsoft Word Guidelines 
Here are a few useful ideas to keep in mind when using Microsoft Word with DMS. 

Close document after viewing or editing 
When a document icon on the Scan or Search screen is double-clicked, the document is 
opened using Microsoft Word.  To accomplish this DMS extracts the document from the 
database to a temporary file for Microsoft Word to access.  DMS attempts to save changes to 
the temporary file made using Microsoft Word back into the database and delete the temporary 
file when viewing or editing is complete.  This cannot take place if the temporary file is still in use 
by Microsoft Word.  To avoid wasting disk space by accumulating unwanted temporary files be 
sure to close the document by choosing Close or Exit from the File menu before returning to 
DMS. 

Save changes 
Changes must be saved using Microsoft Word when a word processor file is edited.  After 
making changes to a document using Microsoft Word choose Save from the File menu or click 
the Save icon in the Microsoft Word toolbox.  Then choose Close or Exit from the File menu 
and minimize word if necessary.  If an attempt is made to close an unsaved document that has 
been changed, Microsoft Word will automatically prompt for changes to be saved. 

Leave Microsoft Word loaded 
To save time when viewing word processor files, don’t exit Microsoft Word after viewing each 
document.  Instead, only close the document in Microsoft Word by choosing Close from the file 
menu.  Then minimize Microsoft Word, press Alt-Tab, or select DMS in the Windows Taskbar 
to return to DMS.  Doing this leaves Microsoft Word running and saves the time required for it 
to load each time a document is viewed. 

Document Type and Keyword Guidelines 
Here are a few useful ideas to keep in mind when setting up document types and keywords. 



Use Zoom 
When defining zone-based keywords, use the Zoom, feature to view the document at a higher 
magnification and place the zone more accurately.  Zoom is also useful with label-based 
keywords for determining the exact format or spelling of label text.  Incremental adjustments to 
zone boundaries may also be made using the up and down arrow keys on the keyboard while 
the cursor is in the Top, Bottom, Left, or Right field. 

Reposition existing zones 
Instead of redrawing an incorrect zone from scratch, click the mouse pointer in the center of the 
zone and drag the box to the desired location. 

Include label punctuation 
Label punctuation is significant and must be included in the label text used to define a keyword.  
For example, if the label appears on the page as “Name:” with a colon, entering the label text 
“Name” without a colon in not adequate for automatic keyword detection. 

Shorten label text 
Avoid using long labels in keyword definitions.  There is a higher chance that automatic 
keyword detection will fail when longer labels are used since the probability of an OCR error 
within the label itself is higher.  Using label text such as “ame:” instead of the longer “Customer 
Name:” will produce more consistent results. 

Allow for inaccurate positioning 
When defining keyword zones, make allowances for the fact that documents may not always be 
formatted in exactly the same way and pages may not always be positioned exactly on the 
scanner glass.  Define keyword zones slightly larger than the zone text to allow for varying 
positioning.  Instead trying to position a zone boundary between words on the page, include 
headings or labels within the keyword zone and specify their automatic removal using the 
Remove feature. 



Extended Search Capabilities 

The extended search capabilities described here enable users of the Document Management System to perform more 
flexible and powerful searches than are currently possible.  The new functions augment current keyword and full-text  
search capabilities with searches using Boolean, wildcard and comparison operators. 

The new search capabilities are described below.  Examples of valid searches using the new operators is also 
described.. Limitations imposed on use of the new operators for the purpose of maximizing performance and 
functionality are also explained. 

Keyword Searches 
The following types of searches are supported when entering the keywords for a keyword search. 

1.  Single-word searches 
Simple single-word keyword searches operate as before. 

2.  OR searches 
OR searches are allowed within a keyword, but not between keywords.  The following is an example of an OR 
keyword search. 
 
Name:  Smith OR Jones OR White 
 
The following search is not possible because the OR operation takes place between different keywords. 
 
Name:       Smith 
-OR- 
Physician:  Jones 

3.  AND searches 
There is an implicit AND operation between different keywords.  .For example,  the search below returns 
documents having the Name Smith and the Physician Jones. 
 
Name:       Smith 
Physician:  Jones 
 
AND searches do not make sense functionally within the same keyword and are not allowed since keywords are 
not multi-valued.  For example, the search below would never return a matching document because it is 
impossible for any document to store both Jones and Smith in a single keyword.  
 
Name:  Smith AND Jones 

4.  NOT searches. 
NOT searches are allowed for single words only, but may be used for several keywords as once.  For example: 
 
Name:       NOT Smith 
Physician:  NOT Jones 
 
Compound NOT searches are not allowed.  In most cases compound NOT searches do not make sense 
functionally for search items that are not multi-valued, such as keywords.  Such searches can usually be 
simplified to a single-word NOT search.  For example, consider the following searches on the Name keyword: 
 
NOT Smith OR Jones     may be simplified to NOT Smith. 
NOT Smith AND Jones    may be simplified to Jones. 
NOT Smith OR NOT Jones may be simplified to (blank) since all keywords match this criteria. 
 



Notice that comp ound searches of the type NOT Smith and NOT Jones cannot be reduced in this way.  These 
types of searches are not allowed because they are very expensive computationally and take a long time to 
process.  If this type of keyword search is required, it may be approximated using two separate searches.  
Alternately, searches of the type NOT Smith and NOT Jones may be performed using the full-text search field 
where these types of compound NOT search are allowed. 

5.  Comparison searches 
Comparison searches return search results by making numeric and date comparisons using the greater than “>” 
and less than “<” operator.  For example, the following search criteria returns documents for Smith with exam 
dates later than 1/1/96 and ages less than 50. 
 
Name:       Smith 
Exam Date:  > 01/01/1996 
Age:        < 50 
 
Comparisons operators may only be used with numbers and dates.  For the sake of simplicity, compound 
comparisons are not allowed within a single keyword.  That is, searches of the type “> 20 AND < 50“ are not 
allowed.  Also for simplicity, the operators “greater than or equal” and “less than or equal” are not supported 
since the search “>= 21 “ may be expressed more simply as “> 20”. 

6.  Wildcard searches 
Wildcard searches provide the capability to search on partial strings using the “*” operator.  For example a 
wildcard search using the search string Smith* returns all keywords starting with Smith such as Smith, 
Smithe and Smithsonian.  Wildcard searches may be used in conjunction with any single-value, OR, or NOT 
keyword search.  The following are examples of wildcard searches. 
 
Name:       Smith* 
Name:       Smith* OR Whit* 
Name:       Smith OR White OR Jon* 
Name:       NOT Smith* 
Exam Date:  01/01/* OR 01/02/* 
Age:        5* OR 6* 
 
Note that Wildcard searches may be combined with the NOT operator for single words within a single keyword.  
However they may not be combined with comparison searches within the same keyword.  That is, searches such 
as “> 01/01/97 OR 02/01/*” are not allowed. 
 
Note that wildcard searches on numbers and dates provide a rudimentary way to overcome the limitations of 
comparison searches.  For example, the wildcard search “5* OR 6*” on the Age keyword may be used to 
approximate the illegal search “>= 50 AND < 70”. 

Full-Text Searches 
The following types of searches are supported when entering the criteria for a full-text search. 

1.  Single-word searches 
Simple single-word full-text or “containing text” searches operate as before. 

2.  OR searches 
OR full-text searches behave the same as for keyword searches.  For example: 
 
Containing Text:  Smith OR Jones OR White 

3.  AND searches 
There is an implicit AND operation between full-text searches and any active keyword search..  In addition, AND 
searches may be used within the full-text search criteria.  For example, the search below returns documents 



having the Name Smith and containing the words abnormal, fibula, and fracture. 
 
Name:             Smith 
Containing Text:  abnormal AND fibula AND fracture 

4.  Nested searches  
Nested full-text searches cannot be processed.  A nested search is a search that contains parenthesis or both 
AND and OR operators.  Following are several examples of nested searches that are not allowed.  Note that in 
the second example there are implied parenthesis around the expression Jones AND White due to the AND 
operator having higher Boolean precedence than the OR operator. 
 
Containing Text:  Smith AND (Jones OR White) 
Containing Text:  Smith OR Jones AND White 

5.  NOT searches. 
NOT searches may be combined with any AND or OR full-text search.  For example: 
 
Containing Text:  Smith AND NOT Jones AND White 
Containing Text:  NOT Smith AND NOT Jones 
Containing Text:  NOT Smith OR Jones OR NOT White 

6.  NEAR Searches 
The NEAR operator provides a mechanism for finding word combinations in a document.  Two words are 
considered to be near each other if there are less than three words between them.  For example, in the sentence 
“The quick brown fox jumped over the log” the words “quick” and “fox” are near each other but “quick” and 
“log” are not.  NEAR full-text searches cannot be combined with AND, OR, or NOT searches.  Two examples of 
NEAR searches are given below. 
 
Containing Text:  Robert NEAR Smith  
Containing Text:  blood NEAR cell 

7.  Wildcard searches 
Full-text wildcard searches behave similar the keyword wildcard searches.  Wildcard searches may be used in 
conjunction with AND, OR, NOT and NEAR full-text searches.  The following are examples of wildcard searches. 
 
Containing Text:  Smith*  
Containing Text:  Smith* AND carpal* 
Containing Text:  Smith OR White OR Jon*  
Containing Text:  Robert NEAR Smith* 
Containing Text:  NOT cappal*  
Containing Text:  syndrome AND NOT carpal* 
Containing Text:  01/01/* OR 01/02/* 
Containing Text:  5* AND 6* 

Custom Searches  
Some possibilities are currently being explored to make searching even more flexible than the features described 
above.  Possible future search capabilities may include some of the following. 

Query builder 
A query-builder screen would allow the user to build and save custom SQL queries using knowledge of the 
underlying database structure.  In this way, specialized searches could be constructed on demand that would 
otherwise not be capable using the built-in search functions. 

Merged searches 
This feature would enable the results of several separate searches to be combined.  Search results could either be 
“added” to show all the results of several searches at once (i.e. a set UNION), or “subtracted” to show only the 



documents that were returned by all of several searches (i.e. a set INTERSECTION).  One way this functionality could 
be implemented is via menu items titled “Add Last Search Result” and “Subtract Last Search Result”.  Another way 
to implement merged searches is via a system screen that lists several search results by name and allows them to be 
combined via a point-and-click interface. 


